Export Cuelist2 for gma2
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This is simple tool to Export Cue List (Sequence) to the grandMA2.

Change Cue Number, Cue Color, Cue Fade or Info from within the application. You can also print your Cue List (Sequence).
Just import to Reaper multimedia file (music or video) you’re working on.

Prepare all Cues (Markers in Reaper) — light changes, accents, solos, etc. that you want to use in show.

Export Cuelist2 for gma2 will finish all work for you by importing to console Of Course:
— Cue List (Sequence)
—Sequence number
—Sequence name

— Page number

—Page name

— Executor number

— Cue Time — for Trigger Time
— Cue Color

— Cue Fade

— Cue Info

As simple as that!
Don’t miss that chance! Do not hesitate and try it completely for free!

Description:

Download and install "Reaper":
http://www.reaper.fm/download.php

Download and install "SWS Extension" for Reaper:
http://www.sws-extension.org/

1. Run Reaper.
2. Open View tab and set Time unit for ruler to Seconds.

& REAPER File FEdit View Insert Item Track Options Actions Extensions Window Help [44.1kHz 24bit WAV : 0/2ch 512spls ~11/20ms] 100% @ Sob. 4.01 01:11:03 jolo Q @ =

Mixer #BM Time ID Description

Master Track
Floating Mixer Master

+ Transport
+ Video

Monitoring FX

Docker
Toolbar Docker

Media Explorer

Routing Matrix

Grouping Matrix

Track Wiring

Project Media/FX Bay ¥B

Track Manager {+38M

Screensets/Layouts RE
+/ Region/Marker Manager

FX Browser OF

Media ltem Properties ]

+/ Big Clock NC
Performance Meter 8P
Peaks Display Settings

Navigator N8V

Tempo Envelope AT

Scale Finder Regions
Virtual MIDI Keyboard XB L | | Markers
#~ Name Start End Length

Showy/hide all floating windows  C38F
Cascade all floating windows

Time unit for ruler Minutes:Seconds
Measures.Beats
Measures.Beats (minimal)
Goto >/ Seconds

Zoom >

Always on top Samples
Fullscreen 38Fn Hours:Minutes:Seconds:Frames

Absolute Frames
Secondary time unit >

Filter: B clear




3. Open Insert tab and insert new Track.

® OfCourse_ExportTT [modified] - REAPER v6.02/64 - Registered to Grzegorz Barszczewski (Licensed for personal/small business use)

ID Description

[ A trim

Insert new track

Insert new track at end of track list
Insert virtual instrument on new track...
Insert track from template

Save tracks as track template...

Remove tracks

Duplicate tracks

Move tracks to new subproject
Render/freeze tracks

MIDI track controls

Lock track controls

Lock track height

Free item positioning

Automatic record-arm when track selected
+ Multichannel track metering

Track Manager (show/hide tracks)...
Track color
Track icon

Track timebase Regions
Track automation mode v Markers
Track performance options b End  Length
Track layout b

Envelopes

Track grouping paramete|
+ Track grouping enabled

SWS Snapshots

Filter:

4. Open Insert tab and Import your media file.

& REAPER File Edit View Insert Item Track Options Actions Extensions Window Help [44.1kHz 24bit WAV : O/2ch 512spls ~11/20ms]  100% @@ Sob. 4.01 00:39:17 jolo Q ® :

1 ) Media file... @& ID Description
| New MIDI item
Empty item

SMPTE LTC/MTC Timecode Generator
Click source

New subproject

Marker
Marker (prompt for name)

ol l-0

Tempo/time signature change marker

Track

Multiple tracks...

Virtual instrument on new track...
Track from template

Regions
v Markers

End  Length




5. Create a Cue List (Sequence) use the Markers and give the names for Cues. Important: don’t use comma (“,”) in cue name.

OfCourse_ExportTT [modified] - REAPER v6.02/64 - Registered to Grzegorz Barszczewski (Licensed for personal/small business use)
ID Description

1 pre show
2 start

0 o c
ol ..o

= larker
o 2 () (o =
0.00d8

canter

Set color... Cancel

Regions
v Markers

#~ Name End  Length

M1 pre show
M2 start

 Cuelist2 for gma2

Filter:

6. Open Extension tab and open Marker List, click rig ouse button and use the tab Convert markers to regio

® Marker List
ID Description

1 pre show
2 start

i

hit

hit

Route

chorus

4
5
6
7 verse
8
9

frase
10 solo

canter

Rename

Set color...

Save marker set...
Delete market set...

! Copy marker set to clipboard
n  Paste marker set from clipboard

N Reorder marker IDs

Reorder region IDs

Delete selected marker(s)
Delete all markers
Delete all regions

Export formatted marker list to clipboard
Export formatted marker list to file
Export format...

£ Convert markers to regions

Convert regions to markers

0 o o

Dock Marker List in Docker
Close window

7. Save Reaper Project.
8. Open View tab and open Region/Marker Manager.
9. Click right mouse button and use the tab Export region/markers, name the text file (*.csv) and save it.




1 preshow i 8 chorus 9 frase
ID Deseription

1 pre show
2 start

3 hit

4 hit

5 hit

6 hit

7 verse

8 chorus

9 frase

10 solo

Region/Marker Manager

4 Regions
Markers

#~ Name Start End Length
R1 pre show 0.000 4174 4174
- O 4174 6.261 2.087
cted markarsEui 6261 8348 2087
Renumber in timeline order (markers, then regions) 8348 10435 2087
10.435 12,622 2.087
12522 14.609 2.087
14.609 22,957 8.348
— 22.957 27130 4174
+ Show track render menu nested by folders 27130  31.304 4174
: 31.304 34.204 2900

Import regions/markers (replace existing)...
Import regions/markers (merge with existing)...
Export regions/markers...

~ v Seek playback when selecting a marker or region
Play region through then repeat or stop when selecting a region

Dock Region Manager in Docker

Close window

Your Cue List (Sequence) is ready a can export it to the grandMA2 use Export Cuelist2 for gma2.

Run Export Cuelist2 for gma2.

Click tab Settings.

1. Set directories for Macro — grandMA2 OnPC Macro Folder or USB Memory Stick Macro Folder.

2. Set the IP to the same as on grandMA2 or grandMA2 OnPC — this is important for Telnet connection.

3. Set the User and Password to be the same as in grandMA2 or grandMA2 OnPC - it is important to keep the user settings when exporting Sequence.
4. You can also set default Trigger, Fade and Color for Cues.

5. Save settings.

{ N Export CueList2 for gma2

Cue Name Settlngs

Document folder (for repaer file)

Sequence number
1

Exec number
fUsers/makus/ownCloud/ExportTC&TT/TC&TT_2020/TT/Reaper_/Reaper_ Browse 7

Page number
1

Macro folder (default: gma2/macros)

fUsers/makus/Music/Export CueList2/gma2/macros Browse
Sequence label

Cuelist

grandMA?2 settings: Colors for triggers Trigger

Page label

user first cue

GO

Page

administrator

password

IP address

127.0.0.1 _ (choose)

Version: Full version

show tutorial on StartUp

GO

admin (choose)

default
Time by

Default fade time
2,09

Load file

Settings
Help

Qur Apps




6. Click tab Load file and select your Cue List (Sequence).

Directly from Reaper Project.

= B Reaper_ e
FRVEITioe Name Date Medified Kind
E) Recents [ ofCourse_ExportTT.RPP 16 marca 2020 20:46 6KB  ReaperProject

Cue Name Trigge
B OfCourse_ExportTT_regions.csv 16 marca 2020 20:46 303 bytes CSV Docu

A\ Applications
€ Downloads
% ownCloud
El Movies

ﬂ Music

[0 Pictures

ﬁ makus

I iOSProjects
B TC&TT_2020
I OneDrive - iglo...
I OneDrive

iCloud

New Folder Cancel

Load file

Settings
Help

Our Apps

Or, from exported text file from Reaper Project (*.csv).

A

= W Reaper_ <
Favorites Name Date Modified Kind
B OfCourse_ExportTT.RPP 16 marca 2020 20:46 5 KB  ReaperProject

Cue Name Trigger  [5) Recents
B 0fCourse_ExportTT_regions.csv 18 marca 2020 20:46 303 bytes  CSV Document

A\ Applications
) Downloads
% ownCloud
— Movies

.‘1 Music

[ Pictures

|/‘. makus

B iOSProjects

B TC&TT_2020

B OneDrive - iglo...
B OneDrive

iCloud

New Folder Cancel

Load file

Settings
Help

Qur Apps




As a result, you will see your Cue List (Sequence).

[ N N ] Export CuelList2 for gma2

Cue Cue Name Trigger Fade Color Info Sequence number
2,09 Exec number
2.09 1

2.09 Page number
2.09 1

2.09 Sequence label
2.09 Cuelist

pre show (c]e]

start Time
hit Time
hit Time
hit Time
hit Time

verse Time
2.09 Page label

2.09 Page

chorus Time

© BN ;A W N

frase Time

€3 €3] K3 X3 K K2 Q) O ]

solo Time 2,09

=}

Load file
Generate files
Connect to MA

Print CueList
Renumber
Settings
Help

Our Apps

Now you can change the Name, Number, Fade, Trigger and set Info, or Color for cues.

[ N N | Export CueList2 for gma2

Cue Cue Name Trigger Fade Color Info Sequence number

change fade time
200 [ Exec number

2.09 1

start change trigger

hit change color

hit change cue name
change info
remove cue

2.09 Page number
2.09 1
2.09 Sequence label

hit

LAl Time 2.09 CuelLlst

2.00 Page label
2.09 Page

2.09 _ Guitar

chorus Time

2
3
4
5
6 hit Time
7
8
L)

Time

O 3 3 O O O O O O

] Follow

Load file
Generate files
Connect to MA

Print CueList
Renumber
Settings
Help

Our Apps




7. Do not forget to set Page number, Executor number, Sequence number, Sequence label, Page label.

Export Cuelist2 for gma2

Cue Name Trigger Time Fade Color Info Sequence number
pre show Go 200 2

start GO 2.09 _ Exec number

hit Time 2.09 2

hit Time
hit Time
hit Time

verse Time

2.09 Page number
2,09 2

2.09 Sequence label
2,09 Export_TT
2,09 Page label
Export TT

chorus Time

2.09

frase Time

€ € ) K € 2 O O O O

solo Follow

Load file
Generate files
Connect to MA

Print CueList
Renumber
Settings
Help

Qur Apps

You can also print Cue List (Sequence).

Export CueList2 for gma2 - Export_TT - Export_TT

Cue Cue name Trigger Time Fade Info
1 pre show GO 2.00
2 start GO 4.174 2.00
3 hit Time 2087 2.00
4 hit Time 2087 2.00
5 hit Time 2087 2.00
6 hit Time 2087 2.00
7 verse Time 2087 2.00
8 chorus Time 8348 2.00
9 frase Time 4.174 2.00
10 solo Follow 4.174 2.00 Guitar




And renumber the cue.

A. Export by Telnet:

L]

o
&
3

© 0N O g kW N

5

Cue Name
pre show
start
hit
hit
hit
hit
verse
chorus
frase

solo

Trigger
(cle]
GO

Time

Time

Time

Time

Time

Time

Time

Follow

Export Cuelist2 for gma2

renumber cue

v all

start cue

from cue

start cue

new cue

renumber

Sequence number
2

Exec number
2

Page number
2

Sequence label
Export TT

Page label
Export TT

Load file
Generate files
Connect to MA

Print CueList
Renumber
Settings
Help

Our Apps

Finally, you have two ways how to export Cue List (Sequence) to gMA2.

1. Run the show on grandMA2 and connect to the computer with Export Cuelist2 for gma2. Or, run the show on grandMA2 OnPC on the same computer.
2. In Global Settings set Telnet to Login Enabled.

Screen 2

Setup/Console/Global Settings

2 Show
tt_2020_v01

Tools

User
administrator

Network
Master 1

ol

EXpOTE 1T

10 solo

1 pre show

VE




3. In Network check IP address — should be the same as in Export Cuelist2 for gma2.

¥, Screen 2

MA-Net Control (Consoles only)

Sessions Stations
SoLE

1D | Name A

| Not connected

Status | Name [ Version Type

Of Course

Export TT

10 solo

1 pre show

4. Now click tab Connect to MA2. You can Merge cues also.

Export CueList2 for gma2

-

Cue Name Trigger Time Fade Cq
pre show GO 2.09 -
start () |
hit Time
hit Time
hit Time
hit Time
verse Time
chorus Time

frase Time

2.09 Export CueList2 for gma2

2.09

2.09
2.09 Cancel No

Do you want to merge cue in all sequence?
(marge don't import color and fade values)

2.09 iabel
209 Export_TT
2.09 Page label
2.09 Export_TT

© BN s W N =

00O 00O 0O KO 0K

solo Follow

=

Load file
Generate files
Connect to MA
Print CueList
Renumber
Settings
Help

Our Apps

Now Export Cuelist2 for gma2 is working, sends a Cue List (Sequence) to gMA2.




Export CueList2 for gma2

o
I
1

Cue Name Trigger Fade umber

Co
200 [
- Export CueList2 for gma2

2.09

% CuelList was exported to grandMA2! See result
209 on desk!
2.09

2.09

pre show GO
start GO
hit Time
hit Time
hit Time
hit Time

verse Time

2.09 iabel
2.09 Export TT

chorus Time 2.09 Page label

© ® N o s W NS

2.09 Export TT

frase Time

© 000K 00 O 0D

salo Follow

=}

Load file
Generate files
Connect to MA

Print CueList
Renumber
Settings
Help

Our Apps

Your Cue List (Sequence) with selected Page, Executor, Trigger, Color, Fade, Info is already in show on grandMA2!

¥, Screen 2
L4

Sequence : Export_TT

2.2 Link Il Auto
Export_TT ) JL‘ Scroll

Ds

Out
Fade

Out Snap

Number Name Delay | Percent

Delay MIB Mode | AE ‘ CMD
pre show Go
start Go
hit Time
hit Time
hit Time
hit Time
verse Time
chorus Time

frase Time

EE ESTE cliow Guitar

0 0N O W

Export T

10 solo

1 pre show

Value

100 %

B. Export by Mac|

Run Export Cuelist2 for gma2.




Click tab Settings.

1. Set directories for Macro — grandMA2 OnPC Macro Folder or USB Memory Stick Macro Folder.

Cue Name

pre show
start

hit

hit

hit

hit

verse

chorus

© ® N O ;AW N

frase

solo

]

2. Click Generate files.

©

Cue Name
pre show
start

hit

hit

hit

hit

verse

chorus

© ® N O ;A W RN S

frase

solo

=

Export CueList2 for gma2
Settings
Document folder (for repaer file)
JUsers/makus/ownCloud/ExportTC&TT/TC&TT_2020/TT/Reaper_/Reaper_
Macro folder (default: gma2/macros)

/Volumes/MAKUS1/gma2/macros

grandMA2 settings: Colors for triggers

user GO

administrator _ (choose)

password Time
admin (choose)

IP address Follow

127.0.01 D (choose)

Version: Full version

show tutorial on StartUp

Export Cuelist2 for gma2

Trigger Time Fade Color Info
(cle]
GO

Cancel

€ € K ) Xy € K © 0O O

Sequence number
3

Exec number
3

Page number
Browse 3
Sequence label
Trigaer Export TT_2
Page label

first cue Export.TT.2

GO

default
Time ¥

Default fade time
2.09

Load file
Generate files
Connect to MA
Print CuelList
Renumber
Settings
Help

Our Apps

Sequence number
3

Exec number
=l

Export CueList2 for gma2

Do you want to merge cue in all sequence?
(marge don't import color and fade values) Page number

3

N
9 Sequence label

Export TT_2
Page label
Export TT_2

Load file
Generate files
Connect to MA
Print CuelList
Renumber
Settings
Help

Qur Apps

Your Cue List (Sequence) with selected Page, Executor, Trigger, Color, Fade, Info is ready to be imported using a Macro from folder in om macro folder on USB Memory Stick!




Export CueList2 for gma2

Cue Name Trigger Time Fade Color Info Sequence number
3

pre show GO
start (cle]
hit
hit
hit
hit

Exec number
Export CuelList2 for gma2

3
< Copy file M.xml from file:///Volumes/MAKUS1/gma2/
macros/ to [Disk]\gma2\macros. Page number

On the Command Line in gmaZ2, write a command: g
import "M" at macro "@" (choose a macro number)
and run your imported macro. Sequence label

Export TT_2
verse U
OK

<2 <> €3 € &> <> <> &>

i Page label
209 Export TT_2

200 [ o=

chorus

© O N O o R W N

frase

<3 >

solo

=

Load file
Generate files
Connect to MA

Print CuelList
Renumber
Settings
Help

Our Apps

3. Run your show on grandMA2.
4. Select Internal Drive or USB Memory Stick - depends where you exported Cue List (Sequence).

Bedl @ VersiOhay: 't 2020 vol*
... thanging drive to USE 1

Alat
emplates

Backup Options

Server Backup: Auto Save:

XPOTL.

10 solo

1 pre show

100 %




5. Write a command: import "m" at macro "@" (choose a Macro number).

#, Screen2
L4

Sequence Export_TT Export_TT

L4 Sequence Bl 2.2 4[

S: Export_TT

Out | Snap

Trig
Delay | Percent

Time
pre show Go 2.09
start Go 2.09
hit Time 2.09
hit Time 2.09
hit Time 2.09
hit Time 2.09
verse Time 2.09
chorus Time 2.09
frase Time 2.09

N ST  olow 209 Guitar

Number Name Fade MIB Maode

O 0O NOOE W N

import “m" at Macro 1|

WTT

1 pre show

100 %

6. Now run this Macro.

¥, Screen2

L4
Exnport CUE
Sequence Export_TT Export_TT Macro OF
i ; COURSE

L4 Sequence E: a;'t T [

out
Fade

out | S

Trig e
Delay | Percent

Time
pre show Go 2.09
start Go 2.09
hit Time 2.09
hit Time 2.09
hit Time 2.09
hit Time 2.09
verse Time 2.09
chorus Time 2.09
frase Time 2.09

I ST - olow 209 Guitar

Number Name Fade Delay MIB Mode

OV 0O NO & WM

<
e

2.2

77
Export_ T

10 solo

1 pre show

100 %




Your Cue List (Sequence) with selected Page, Executor, Trigger, Color, Fade, Info is already in show on grandMA2!

#, Screen2
Macro OF

COURSE

E: 3.3
S: Export_TT_2 3

> Export CUE
Sequence *port_ : Export_TT E/.pnrzt_TT ‘

. ‘Sequence

Number g Fade Info elay 2 > MIB

Time
Time
Time
verse Time
chorus Time
frase Time
Follow Guitar

1 pre show

|
|

=

1  J

Contact us:
support@ofcourse.com.pl




